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CHAPTER 1 - GETTING STARTED

1.1 What is SQL Server Report Builder?

SQL Server Report Builder allows you to create, manage and share reports.  You can see 
examples of the types of reports you can create in the diagram below:

Charts allow you to display data graphically.

A matrix groups data into rows and columns.

Indicators and gauges allow you to replace a boring list of numbers with a 
set of interesting icons and simple charts.

You can add parameters to a report to allow users to 
control what data they see.

Even a boring table can become exciting by adding 
interactive elements to it.
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Related Software

Report Builder is just one of many applications in the Microsoft SQL Server suite of software.  You 
can see an overview of some of the software mentioned in this manual in the table below:

Name Description

SQL Server The core component of the SQL Server suite of software.  This 
comprises the database engine which deals with storing and serving 
large volumes of data for applications designed by developers.

SQL Server Management Studio An application for creating and managing SQL Server databases and 
various other associated objects.

SQL Server Configuration Manager A tool for controlling which components of a SQL Server are running.

SQL Server Reporting Services The report server component of SQL Server which deals with storing 
reports and serving them to applications or users who request them.

Reporting Services Configuration Manager A tool for configuring the various aspects of a report server.

Visual Studio Microsoft’s flagship development tool which allows you to create many 
different types of applications and projects.

SQL Server Data Tools A set of templates for Visual Studio which allows you to create and 
deploy SQL Server Reporting Services reports.

SQL Server Report Builder A simple desktop application for creating SQL Server Reporting 
Services reports.

Reporting Services Web Portal A web-based application for viewing and managing reports that have 
been deployed to a report server.

This manual assumes that you’re a report author rather than a SQL Server 
developer and so you won’t need to use many of the applications mentioned in the 
table above.  It can be handy to understand how everything fits together however!

Wise 
Owl’s 
Hint
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1.2 Installing Report Builder

You can install Report Builder from a couple of locations, as described in this section.

Installing from the Microsoft Website

You can use a search engine to find the Microsoft download page for Report Builder:

Installing from the SSRS Web Portal

The Reporting Services Web Portal runs in a web browser and allows you to view reports that 
you’ve saved to a Report Server.  You can also install Report Builder from the web portal:

You could also just type 
this URL into your web 
browser.

Click here to download 
the installer file and then 
run it to install Report 
Builder on your machine.

The examples shown in 
this manual use a 
version of Report Builder 
released on the 8th of 
January 2018.

The URL of the web 
portal will depend on the 
configuration of your 
report server.  How to 
find the web portal URL 
is covered later in this 
courseware.

From the menu, choose 
Report Builder and then 
follow the instructions to 
install the software.



Chapter 1 - Getting Started

© Copyright 2025  Page 13

1.3 Running Report Builder

Once you’ve installed it, you can run Report Builder from the Start menu:

The Getting Started Dialog Box

By default, Report Builder displays the Getting Started dialog box when you open the application:

You can find and click the shortcut for Report Builder 
that is automatically added to the Start menu when 
you install the software.

You could also click the Search tool and type in 
the name of the application.  Click the link that 
appears when the search has finished.

You can prevent this dialog 
box appearing in future by 
checking this box.

You can click various options 
on the dialog box to start 
creating different items.

You can click here to close 
the dialog box and start 
working with a blank report.
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1.4 The Report Builder Screen

Report Builder has several views and windows that you’ll use when creating reports.  You can see 
an overview of the screen in which you’ll spend most of your time in the diagram below:

The File menu contains 
options for opening, saving 
and creating new reports.

The Home tab of the ribbon has a variety 
of options for formatting and editing parts 
of your report.

You can close Report Builder by 
clicking the cross in the top-right 
corner of the window.

You may see a number of windows 
and panels around the border of the 
main Report Builder window.  The 
next page describes these windows.

The main part of the 
screen is taken up by 
the report you’re 
currently working on.

These buttons allow 
you to run the report 
and switch back to 
the design view.

You can zoom 
in and out on 
the report using 
this slider.
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Opening and Closing Windows

Report Builder has several windows and panels that you can open and close as and when you 
need them.

To reopen any windows that you’ve closed, choose View from the ribbon and select the window 
that you want to display.

The Main Windows

You can see a description of the main windows and panels in the table below:

Name What it’s for What it looks like

Properties Displays the attributes of any 
object that you have 
selected.  You can change 
these properties to alter the 
object in various ways.

Report Data Allows you to create 
connections to data sources 
and queries to retrieve data 
that will be displayed in the 
report.

Grouping 
Pane

Allows you to control how the 
selected report item is 
grouped.

Parameters 
Pane

Allows you to create and edit 
report parameters.

Some windows have a cross at the 
top-right corner.  You can click this 
cross to close the window.

On the View tab of the ribbon check the box 
next to the window that you want to display.

You can uncheck the box next to a window 
that you want to hide.
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1.5 Using a Report Server

In Report Builder you can work with reports that are stored locally on your machine as well as files 
stored centrally on a report server.

Connecting to a Report Server

To use files on a report server you first need to connect to it:

Setting a Default Report Server

You can set a default report server so that you don’t have to manually choose to connect to one 
each time you open Report Builder.  To do this, from the ribbon select File | Options

Connecting to a report server means that you can save your reports in a location 
that other people can see.  You can also access other shared resources such as 
data sources and datasets, which can make building reports much easier!

Wise 
Owl’s 
Hint

a) At the bottom of the Report 
Builder window, click Connect.

b) Ask your friendly SQL Server 
administrator for the URL of the 
report server and enter it here.

c) Click Connect to connect 
to the report server.

On the Settings page of the dialog box that appears, enter the report server URL into this box and then click  OK 
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Finding the URL of the Report Server

If you don’t have a SQL Server administrator to ask, and you have access to the report server, you 
can locate its URL in the SQL Server Management Studio application.

a) If you have the application installed, 
in the Start menu right-click on it 
and choose Run as Administrator.

b) Choose a Reporting Services 
server and select or enter its name.

c) Click here to connect to the server.

d) Right-click the server at the top of the Object 
Explorer window and choose Properties.

e) On the General page of the dialog box which appears 
you can copy the report server URL from this text box.
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CHAPTER 2 - WORKING WITH REPORTS

2.1 Creating Reports

The easiest way to create a new report is simply to open Report Builder:

Choosing to Create a New Report

You can also create a new report when Report Builder is 
open:

Ribbon Keyboard

File | New  Ctrl  +  N  

You can only have one report open at a time in Report Builder.  Creating a new 
report will automatically close the one you’re working on (prompting you to save it if 
necessary).

Wise 
Owl’s 
Hint

If the Getting Started dialog box appears when you 
open Report Builder, click Blank Report to create a 
new report.

You can also close the dialog box to see the blank 
report that is created automatically when you open 
Report Builder.
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2.2 Opening and Closing Reports

Opening Existing Reports

To open an existing report:

You can then browse for the report you want to open on the dialog box which appears:

Closing a Report

You can close a report by closing Report Builder.

Ribbon Keyboard

File | Open  Ctrl  +  O  

Click here to search for reports 
saved on a report server.

Choose one of these options to 
find reports saved on your local 
machine.

You can double-click on a report 
to open it.

You can also click on a report and 
then click Open.

Click the cross in the top-right corner of the 
screen to close Report Builder and the report 
you have open.
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2.3 Saving Reports

You can save a report to either your local machine or to a report server.

Saving a Report

To save a report that you’re working on:

If you’ve previously saved the report it will be saved with the same name in the same location.  If 
this is the first time you’ve saved the report, you’ll be asked where you’d like to save it:

Saving a Report with a New Name

If you’d like to save a report that you’ve previously saved with a new name or in a new location you 
can do so by choosing File | Save As from the ribbon:

Ribbon Keyboard Toolbar

File | Save  Ctrl  +  S  

Click here to choose to save a report on a 
report server.  You’ll then need to browse 
to the one you want to use.

Choose one of these options to select a 
location on your local machine.  You can 
then browse to the exact place you want.

Type a name for the report in this text box.

Click Save to save the report in the place 
you’ve selected.

From the File menu, 
choose this option to 
pick a new name and 
location for the report 
you’re saving.
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2.4 Running Reports

Your reports look different when you’re creating them compared to when you run them.  You’ll 
need to switch between design view and preview to check that the report looks sensible.

Design View and Report Preview

When you create a report it will automatically open in design view.  This is where you’ll spend most 
of your time as a report author.  You can switch a report to a preview to running it.

You can switch between design view and preview using two buttons in the bottom-
right of the Report Builder window.

Wise 
Owl’s 
Hint

In design view you can make changes to the report’s 
appearance.  To see what it looks like, click Run to 
switch to the report preview.

In preview you can see the report’s data (and print or 
export it if you want to).  You can click Design to 
return to design view and make further changes.

Use these buttons to switch views.
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  Power Automate (both)  
  

 

 

 
 

 
    

        

 

 
 

 
    

 

S
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e
r
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 SQL  
   

  Reporting Services  
   

  Report Builder  
   

  Integration Services  
   

  Analysis Services  
 

  

 

 
 

 
    

        

 

 
 

 
    

 

C
o

d
in

g
 

 Visual C#   
   

  VB programming    
 

  MySQL  
   

  Python  
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